


A Roadmap for Selecting  
a Statistical Method

Data Analysis Task For Numerical Variables For Categorical Variables

Describing a group or 
several groups

Ordered array, stem-and-leaf display, frequency distribution, relative 
frequency distribution, percentage distribution, cumulative percentage 
distribution, histogram, polygon, cumulative percentage polygon, bullet 
maps, sparklines, gauges, treemaps (Sections 2.2, 2.4, 17.1)

Mean, median, mode, geometric mean, quartiles, range, interquartile range, 
standard deviation, variance, coefficient of variation, skewness, kurtosis, 
boxplot, normal probability plot (Sections 3.1, 3.2, 3.3, 6.3) 

Index numbers (online Section 16.8) 

Gauges, bullet graphs, and treemaps (Section 17.1)

Summary table, bar chart, pie chart, Pareto chart 
(Sections 2.1 and 2.3)

Inference about one group Confidence interval estimate of the mean (Sections 8.1 and 8.2)

t test for the mean (Section 9.2)

Chi-square test for a variance or standard deviation (online Section 12.7)

Confidence interval estimate of the proportion 
(Section 8.3)

Z test for the proportion (Section 9.4)

Comparing two groups Tests for the difference in the means of two independent populations  
(Section 10.1)

Wilcoxon rank sum test (Section 12.4)

Paired t test (Section 10.2)

F test for the difference between two variances (Section 10.4)

Wilcoxon signed ranks test (online Section 12.8)

Z test for the difference between two proportions 
(Section 10.3)

Chi-square test for the difference between two 
proportions (Section 12.1)

McNemar test for two related samples (online  
Section 12.6)

Comparing more than two 
groups

One-way analysis of variance for comparing several means (Section 11.1)

Kruskal-Wallis test (Section 12.5)

Randomized block design (Section 11.2)

Two-way analysis of variance (Section 11.3)

Friedman rank test (online Section 12.9)

Chi-square test for differences among more than two 
proportions (Section 12.2)

Analyzing the relationship 
between two variables

Scatter plot, time series plot (Section 2.5)

Covariance, coefficient of correlation (Section 3.5)

Simple linear regression (Chapter 13)

t test of correlation (Section 13.7)

Time-series forecasting (Chapter 16) 

Sparklines (Section 17.1)

Contingency table, side-by-side bar chart,  
PivotTables (Sections 2.1, 2.3, 2.6)

Chi-square test of independence (Section 12.3)

Analyzing the relationship 
between two or more 
variables

Multiple regression (Chapters 14 and 15)

Regression trees (Section 17.3)

Neural nets (Section 17.4)

Cluster analysis (Section 17.5)

Multidimensional scaling (Section 17.6)

Multidimensional contingency tables (Section 2.7)

Drilldown and slicers (Section 17.1)

Logistic regression (Section 14.7)

Classification trees (Section 17.3)

Neural nets (Section 17.4)
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Preface
Over a generation ago, advances in “data processing” led to new business opportunities as first 
centralized and then desktop computing proliferated. The Information Age was born. Computer sci-
ence became much more than just an adjunct to a mathematics curriculum, and whole new fields of 
studies, such as computer information systems, emerged.

More recently, further advances in information technologies have combined with data analysis 
techniques to create new opportunities in what is more data science than data processing or com-
puter science. The world of business statistics has grown larger, bumping into other disciplines. 
And, in a reprise of something that occurred a generation ago, new fields of study, this time with 
names such as informatics, data analytics, and decision science, have emerged.

This time of change makes what is taught in business statistics and how it is taught all the 
more critical. These new fields of study all share statistics as a foundation for further learning. We 
are accustomed to thinking about change, as seeking ways to continuously improve the teaching 
of business statistics have always guided our efforts. We actively participate in Decision Sciences 
Institute (DSI), American Statistical Association (ASA), and Making Statistics More Effective in 
Schools and Business (MSMESB) conferences. We use the ASA’s Guidelines for Assessment and 
Instruction (GAISE) reports and combine them with our experiences teaching business statistics to 
a diverse student body at several large universities.

What to teach and how to teach it are particularly significant questions to ask during a time of 
change. As an author team, we bring a unique collection of experiences that we believe helps us find 
the proper perspective in balancing the old and the new. Our two lead authors, Mark L. Berenson 
and David M. Levine, were the first educators to create a business statistics textbook that discussed 
using statistical software and incorporated “computer output” as illustrations—just the first of many 
teaching and curricular innovations in their many years of teaching business statistics. Our newest 
co-author, Kathryn A. Szabat, has provided statistical advice to various business and nonbusiness 
communities. Her background in statistics and operations research and her experiences interacting 
with professionals in practice have guided her, as departmental chair, in developing a new, interdis-
ciplinary academic department, Business Systems and Analytics, in response to the technology- and 
data-driven changes in business today.

All three of us benefit from our many years teaching undergraduate business subjects and the 
diversity of interests and efforts of our past co-author, Timothy Krehbiel. We are pleased to offer the 
innovations and new content that are itemized starting on the next page. As in prior editions, we are 
guided by these key learning principles:

•	 Help students see the relevance of statistics to their own careers by providing examples 
drawn from the functional areas in which they may be specializing.

•	 Emphasize interpretation of statistical results over mathematical computation.
•	 Give students ample practice in understanding how to apply statistics to business.
•	 Familiarize students with how to use statistical software to assist business decision making.
•	 Provide clear instructions to students for using statistical applications.

Read more about these principles on page xxviii.

What’s New and Innovative in This Edition?
This thirteenth edition of Basic Business Statistics contains both new and innovative features and 
content, while refining and extending the use of the DCOVA (Define, Collect, Organize, Visualize, 
and Analyze) framework, first introduced in the twelfth edition as an integrated approach for apply-
ing statistics to help solve business problems.



xx	 Preface

Innovations
Getting Started: Important Things to Learn First—In a time of change, you can never know exactly 

what knowledge and background students bring into an introductory business statistics classroom. 
Add that to the need to curb the fear factor about learning statistics that so many students begin with, 
and there’s a lot to cover even before you teach your first statistical concept.

We created “Getting Started: Important Things to Learn First” to meet this challenge. This 
unit sets the context for explaining what statistics is (not what students may think!) while ensur-
ing that all students share an understanding of the forces that make learning business statistics 
critically important today. Especially designed for instructors teaching with course management 
tools, including those teaching hybrid or online courses, “Getting Started” has been developed to 
be posted online or otherwise distributed before the first class section begins and is available for 
download as explained in Appendix C.

Student Tips—In-margin notes reinforce hard-to-master concepts and provide quick study tips for 
mastering important details.

Discussion of Business Analytics—“Getting Started: Important Things to Learn First” quickly 
defines business analytics and big data and notes how these things are changing the face of  
statistics.

This material serves as an introduction to the new “Business Analytics” chapter (Chapter 17).  
This new chapter begins with a scenario that uses the management of a theme park to introduce 
applications of business analytics. The chapter begins by discussing descriptive visualization 
methods used for general oversight and applies them to issues raised in the scenario. Using other 
examples, the chapter then discusses the predictive analytics methods classification and regres-
sion trees, neural nets, cluster analysis, and multidimensional scaling that are in common use 
today.

Because standard Microsoft Excel and Minitab offer little or no support for the methods dis-
cussed, the chapter uses results created using JMP, the interactive data analysis software from the 
SAS Institute, and Tableau Public, the Web-based data visualization tool from Tableau Software, 
where appropriate. For those interested, a special Software Guide located at the end of the chapter 
explains how to use these two programs (and Microsoft Excel) to construct the results shown in 
the chapter.

PHStat version 4—For Microsoft Excel users, this new version of the Pearson Education statistics 
add-in contains several new and enhanced procedures, simpler set up, and is compatible with both 
Microsoft Windows and (Mac) OS X Excel versions.

Chapter Short Takes Online PDF documents (available for download as explained in Appendix C) 
that supply additional insights or explanations to important statistical concepts or details about 
the results presented in this book.

Revised and Enhanced Content
New Continuing End-of-Chapter Cases—This thirteenth edition features several new end-of-chapter 

cases. New and recurring throughout the book is a case that concerns analysis of sales and market-
ing data for home fitness equipment (CardioGood Fitness), a case that concerns pricing decisions 
made by a retailer (Sure Value Convenience Stores), and the More Descriptive Choices Follow-Up 
case, which extends the use of the retirement funds sample first introduced in Chapter 2. Also recur-
ring is the Clear Mountain State Student Surveys case, which uses data collected from surveys of 
undergraduate and graduate students to practice and reinforce statistical methods learned in vari-
ous chapters. This case replaces end-of-chapter questions related to the student survey database in 
the previous edition. Joining the Mountain States Potato Company regression case of the previous 
edition are new cases in simple linear regression (Brynne Packaging) and multiple regression (The 
Craybill Instrumentation Company).

Many New Applied Examples and Problems—Many of the applied examples throughout this 
book use new problems or revised data. Approximately 44% of the problems are new to this 
edition. The ends-of-section and ends-of-chapter problem sets contain many new problems that 
use data from The Wall Street Journal, USA Today, and other sources.

Revised Using Statistics Scenarios—There are new or revised Using Statistics scenarios in five 
chapters.
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Checklist for Preparing to Use Microsoft Excel or Minitab with This Book—Found in Section 
GS.4 of “Getting Started: Important Things to Learn First,” this checklist explains for students 
which skills they will need and where they will find information about those skills in the book.

Revised Appendices Keyed to the Preparing to Use Microsoft Excel Checklist—The revised 
Appendix B discusses the Excel skills that readers need to make best use of the In-Depth Excel 
instructions in this book. Appendix F presents useful Excel knowledge, including a discussion 
of the new worksheet function names that were introduced in Excel 2010. Appendix G presents 
FAQs about using Excel and Minitab with this book.

Configuring Microsoft Excel Appendix—This revised Appendix D discusses the procedures and 
practices that will help readers that use Microsoft Excel to avoid common technical problems that 
might otherwise arise as they learn business statistics with this book.

Distinctive Features
We have continued many of the traditions of past editions and have highlighted some of these 
features below.

Using Statistics Business Scenarios—Each chapter begins with a Using Statistics example that 
shows how statistics is used in the functional areas of business—accounting, finance, information 
systems, management, and marketing. Each scenario is used throughout the chapter to provide an 
applied context for the concepts. The chapter concludes with a Using Statistics, Revisited section 
that reinforces the statistical methods and applications discussed in each chapter.

Emphasis on Data Analysis and Interpretation of Excel and Minitab Results—We believe 
that the use of computer software is an integral part of learning statistics. Our focus emphasizes 
analyzing data by interpreting results while reducing emphasis on doing computations. For 
example, in the coverage of tables and charts in Chapter 2, the focus is on the interpretation of 
various charts and on when to use each chart. In our coverage of hypothesis testing in Chapters 9  
through 12, and regression and multiple regression in Chapters 13 through 15, extensive com-
puter results have been included so that the p-value approach can be emphasized.

Pedagogical Aids—An active writing style is used, with boxed numbered equations, set-off 
examples to provide reinforcement for learning concepts, student tips, problems divided into 
“Learning the Basics” and “Applying the Concepts,” key equations, and key terms.

Digital Cases—In the Digital Cases, available for download as explained in Appendix C, learners 
must examine interactive PDF documents to sift through various claims and information in order 
to discover the data most relevant to a business case scenario. Learners then determine whether 
the conclusions and claims are supported by the data. In doing so, learners discover and learn how 
to identify common misuses of statistical information. (Instructional tips for using the Digital 
Cases and solutions to the Digital Cases are included in the Instructor’s Solutions Manual.)

Answers—Most answers to the even-numbered exercises are included at the end of the book.

Flexibility Using Excel—For almost every statistical method discussed, this book presents more 
than one way of using Excel. Students can use In-Depth Excel instructions to directly work with 
worksheet solution details or they can use either the PHStat instructions or the Analysis ToolPak 
instructions to automate the creation of those worksheet solutions.

PHStat—PHStat is the Pearson Education statistics add-in that you use with Microsoft Excel to 
help build solutions to statistical problems. With PHStat, you fill in simple-to-use dialog boxes 
and watch as PHStat creates a worksheet solution for you. PHStat allows you to use the Microsoft 
Excel statistical functions without having to first learn advanced Excel techniques or worrying 
about building worksheets from scratch. As a student studying statistics, you can focus mainly on 
learning statistics and not worry about having to fully master Excel as well.

Unlike other programs, PHStat solutions are real worksheets that contain real Excel calculations 
(called formulas in Excel). You can examine the contents of worksheet solutions to learn the 
appropriate functions and calculations necessary to apply a particular statistical method. With 
most of these worksheet solutions, you can change worksheet data and immediately see how 
those changes affect the results. This book uses PHStat version 4 which includes over 60 proce-
dures that create Excel worksheets and charts for these statistical methods:

Descriptive Statistics: boxplot, descriptive summary, dot scale diagram, frequency distribution, 
histogram & polygons, Pareto diagram, scatter plot, stem-and-leaf display, one-way tables & 
charts, and two-way tables & charts
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Probability and probability distributions: simple & joint probabilities, normal probability plot, 
and binomial, exponential, hypergeometric, and Poisson probability distributions

Sampling: sampling distributions simulation

Confidence interval estimation: for the mean, sigma unknown; for the mean, sigma known, for 
the population variance, for the proportion, and for the total difference

Sample size determination: for the mean and the proportion

One-sample tests: Z test for the mean, sigma known; t test for the mean, sigma unknown;  
chi-square test for the variance; and Z test for the proportion

Two-sample tests (unsummarized data): pooled-variance t test, separate-variance t test, paired t 
test, F test for differences in two variances, and Wilcoxon rank sum test

Two-sample tests (summarized data): pooled-variance t test, separate-variance t test, paired t test, 
Z test for the differences in two means, F test for differences in two variances, chi-square test for 
differences in two proportions, Z test for the difference in two proportions, and McNemar test

Multiple-sample tests: chi-square test, Marascuilo procedure Kruskal-Wallis rank test, Levene 
test, one-way ANOVA, Tukey-Kramer procedure randomized block design, and two-way 
ANOVA with replication

Regression: simple linear regression, multiple regression, best subsets, stepwise regression, and 
logistic regression

Control charts: p chart, c chart, and R and Xbar charts.

Decision-making: covariance and portfolio management, expected monetary value, expected 
opportunity loss, and opportunity loss

Data preparation: stack and unstack data

See Appendix Section C.4 for more information about PHStat.

Visual Explorations—The series of Excel workbooks that allow students to interactively explore 
important statistical concepts in descriptive statistics, the normal distribution, sampling distribu-
tions, and regression analysis. For example, in descriptive statistics, students observe the effect 
of changes in the data on the mean, median, quartiles, and standard deviation. With the normal 
distribution, students see the effect of changes in the mean and standard deviation on the areas 
under the normal curve. In sampling distributions, students use simulation to explore the effect of 
sample size on a sampling distribution. In regression analysis, students have the opportunity to fit 
a line and observe how changes in the slope and intercept affect the goodness of fit. The Visual 
Explorations workbooks are available for download as explained in Appendix C. (See Appendix 
Section C.4 to learn more about the workbooks that comprise Visual Explorations.)

Chapter-by-Chapter Changes Made for This Edition
Besides the new and innovative content described in “What’s New and Innovative in This Edition?” the 

thirteenth edition of Basic Business Statistics contains the following specific changes to each chap-
ter. Highlights of the changes to the individual chapters are as follows:

Getting Started: Important Things to Learn First—This all-new chapter includes new material on 
business analytics and introduces the DCOVA framework and a basic vocabulary of statistics, both of 
which were introduced in Chapter 1 of the twelfth edition.

Chapter 1—Collecting data has been relocated to this chapter from Section 2.1. Sampling meth-
ods and types of survey errors have been relocated from Sections 7.1 and 7.2. There is a new  
subsection on data cleaning. The CardioGood Fitness and Clear Mountain State Surveys cases 
are included.

Chapter 2—Section 2.1, “Data Collection,” has been moved to Chapter 1. The chapter uses a new 
data set that contains a sample of 316 mutual funds and a new set of restaurant cost data. The 
CardioGood Fitness, The Choice Is Yours Follow-up, and Clear Mountain State Surveys cases 
are included.

Chapter 3—For many examples, this chapter uses the new mutual funds data set that is introduced 
in Chapter 2. There is increased coverage of skewness and kurtosis. There is a new example on 
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computing descriptive measures from a population using “Dogs of the Dow.” The CardioGood 
Fitness, More Descriptive Choices Follow-up, and Clear Mountain State Surveys cases are 
included.

Chapter 4—The chapter example has been updated. There are new problems throughout the chap-
ter. The CardioGood Fitness, The Choice Is Yours Follow-up, and Clear Mountain State Surveys 
cases are included.

Chapter 5—There is an additional example on applying probability distributions in finance, and 
there are many new problems throughout the chapter. The notation used has been made more 
consistent.

Chapter 6—This chapter has an updated Using Statistics scenario and some new problems. The 
CardioGood Fitness, More Descriptive Choices Follow-up, and Clear Mountain State Surveys 
cases are included.

Chapter 7—Sections 7.1 and 7.2 have been moved to Chapter 1. An additional example of sam-
pling distributions from a larger population has been included.

Chapter 8—This chapter includes an updated Using Statistics scenario and new examples and 
exercises throughout the chapter. The Sure Value Convenience Stores, CardioGood Fitness, More 
Descriptive Choices Follow-up, and Clear Mountain State Surveys cases are included. The sec-
tion “Applications of Confidence Interval Estimation in Auditing” has been moved online. There 
is an online section on bootstrapping.

Chapter 9—This chapter includes additional coverage of the pitfalls of hypothesis testing. The 
Sure Value Convenience Stores case is included.

Chapter 10—This chapter has an updated Using Statistics scenario, a new example on the paired 
t-test on textbook prices, and a new example on the Z-test for the difference between two pro-
portions. The Sure Value Convenience Stores, CardioGood Fitness, More Descriptive Choices 
Follow-up, and Clear Mountain State Surveys cases are included. There is a new online section 
on Effect Size.

Chapter 11—The chapter has a new Using Statistics scenario that relates to a mobile electron-
ics merchandiser that replaces the Perfect Parachutes scenario. This chapter includes the Sure 
Value Convenience Stores, CardioGood Fitness, More Descriptive Choices Follow-up, and Clear 
Mountain State Surveys cases. It now includes an online section on fixed effects, random effects, 
and mixed effects models.

Chapter 12—The chapter includes many new problems. This chapter includes the Sure Value 
Convenience Stores, CardioGood Fitness, More Descriptive Choices Follow-up, and Clear 
Mountain State Surveys cases. The McNemar test and the Chi-square test for a standard deviation 
or variance are now online sections.

Chapter 13—The Using Statistics scenario has been updated and changed, with new data used 
throughout the chapter. This chapter includes the Brynne Packaging case.

Chapter 14—The online section on influence analysis has been moved into the text.

Chapter 15—This chapter includes the Sure Value Convenience Stores, Craybill Instrumentation, 
and More Descriptive Choices Follow-up cases.

Chapter 16—This chapter includes new data involving movie attendance in Section 16.3 and 
updated data for The Coca-Cola Company in Sections 16.4 through 16.6 and Wal-Mart Stores, 
Inc., in Section 16.7. In addition, most of the problems are new or updated.

Chapter 17—This is the new business analytics chapter already discussed in Innovations on page 
xxiv. This chapter has been designed so that the descriptive methods or any of the predictive 
analytics methods can be taught separately and apart from the rest of the chapter should time not 
permit coverage of the entire chapter.

Chapter 18—This chapter now includes some new problems.

Chapter 19—The “Statistical Applications in Quality Management” chapter has been renumbered 
as Chapter 19 and moved online, where is is available for download as explained in Appendix C.

Chapter 20—The “Decision Making” chapter has been renumbered as Chapter 20 and remains 
available for download as explained in Appendix C.
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About Our Educational Philosophy
In Our Starting Point at the beginning of this preface, we stated that we are guided by these key learn-
ing principles:

•	 Help students see the relevance of statistics to their own careers by providing examples 
drawn from the functional areas in which they may be specializing.

•	 Emphasize interpretation of statistical results over mathematical computation.
•	 Give students ample practice in understanding how to apply statistics to business.
•	 Familiarize students with how to use statistical software to assist business decision making.
•	 Provide clear instructions to students for using statistical applications.

The following further explains these principles:

1.	 Help students see the relevance of statistics to their own careers by providing examples 
drawn from the functional areas in which they may be specializing. Students need a 
frame of reference when learning statistics, especially when statistics is not their major. That 
frame of reference for business students should be the functional areas of business, such as 
accounting, finance, information systems, management, and marketing. Each statistics topic 
needs to be presented in an applied context related to at least one of these functional areas. 
The focus in teaching each topic should be on its application in business, the interpretation 
of results, the evaluation of the assumptions, and the discussion of what should be done if 
the assumptions are violated.

2.	 Emphasize interpretation of statistical results over mathematical computation. 
Introductory business statistics courses should recognize the growing need to interpret statisti-
cal results that computerized processes create. This makes the interpretation of results more 
important than knowing how to execute the tedious hand calculations required to produce them.

3.	 Give students ample practice in understanding how to apply statistics to business. Both 
classroom examples and homework exercises should involve actual or realistic data as much 
as possible. Students should work with data sets, both small and large, and be encouraged 
to look beyond the statistical analysis of data to the interpretation of results in a managerial 
context.

4.	 Familiarize students with how to use statistical software to assist business decision 
making. Introductory business statistics courses should recognize that programs with sta-
tistical functions are commonly found on a business decision maker’s desktop computer. 
Integrating statistical software into all aspects of an introductory statistics course allows the 
course to focus on interpretation of results instead of computations (see point 2).

5.	 Provide clear instructions to students for using statistical applications. Books should explain 
clearly how to use programs such as Microsoft Excel and Minitab with the study of statistics, 
without having those instructions dominate the book or distract from the learning of statistical 
concepts.

Student Resources
Student Solutions Manual, by Professor Pin Tian Ng of Northern Arizona University and accu-

racy checked by Annie Puciloski, provides detailed solutions to virtually all the even-numbered  
exercises and worked-out solutions to the self-test problems (ISBN-10: 0-321-92670-6; ISBN-13: 
978-0-321-92670-8).

Online resources—The complete set of online resources are discussed fully in Appendix C, which 
also explains how to download these resources. These resources include the Excel and Minitab 
Data Files that contain the data used in chapter examples or named in problems and end-of- 
chapter cases; the Excel Guide Workbooks that contain templates or model solutions for applying 
Excel to a particular statistical method; the Digital Cases PDF files that support the end-of-chapter 
Digital Cases; the Visual Explorations Workbooks that interactively demonstrate various key 
statistical concepts; and the PHStat add-in that simplifies the use of Microsoft Windows or OS X 
Microsoft Excel with this book, as explained in Section EG.1.



	 Preface	 xxv

The online resources also include the Chapter Short Takes and Online Topic Sections that 
expand and extend the discussion of statistical concepts worksheet-based solutions as well as 
the full text of two additional chapters, “Statistical Applications in Quality Management” and 
“Decision Making.”

Instructor Resources
The following supplements are among the resources available to adopting instructors at the Instructor’s 
Resource Center, located at www.pearsonhighered.com/irc.

•	 Instructor’s Solutions Manual, by Professor Pin Tian Ng of Northern Arizona University and 
accuracy checked by Annie Puciloski, includes solutions for end-of-section and end-of-chapter 
problems, answers to case questions, where applicable, and teaching tips for each chapter.

•	 Lecture PowerPoint Presentations, by Professor Patrick Schur of Miami University and 
accuracy checked by David Levine and Kathryn Szabat, are available for each chapter. The 
PowerPoint slides provide an instructor with individual lecture outlines to accompany the 
text. The slides include many of the figures and tables from the text. Instructors can use these 
lecture notes as is or can easily modify the notes to reflect specific presentation needs.

•	 Test Bank, by Professor Pin Tian Ng of Northern Arizona University, contains true/false, 
multiple-choice, fill-in, and problem-solving questions based on the definitions, concepts, 
and ideas developed in each chapter of the text. 

•	 TestGen® (www.pearsoned.com/testgen) enables instructors to build, edit, print, and 
administer tests using a computerized bank of questions developed to cover all the objec-
tives of the text. TestGen is algorithmically based, allowing instructors to create multiple but 
equivalent versions of the same question or test with the click of a button. Instructors can also 
modify test bank questions or add new questions. The software and test bank are available for 
download from Pearson Education’s online catalog.

MathXL® for Statistics Online Course (access code required) MathXL® is the homework and 
assessment engine that runs MyStatLab. (MyStatLab is MathXL plus a learning management 
system.)

With MathXL for Statistics, instructors can:

•	 Create, edit, and assign online homework and tests using algorithmically generated exercises 
correlated at the objective level to the textbook.

•	 Create and assign their own online exercises and import TestGen tests for added flexibility.
•	 Maintain records of all student work, tracked in MathXL’s online gradebook.

With MathXL for Statistics, students can:

•	 Take chapter tests in MathXL and receive personalized study plans and/or personalized 
homework assignments based on their test results.

•	 Use the study plan and/or the homework to link directly to tutorial exercises for the objec-
tives they need to study.

•	 Access supplemental animations directly from selected exercises.
•	 Knowing that students often use external statistical software, we make it easy to copy our 

data sets, both from the eText and the MyStatLab questions, into StatCrunch™, Microsoft 
Excel, Minitab, and a variety of other software packages.

MathXL for Statistics is available to qualified adopters. For more information, visit www.mathxl 
.com or contact your Pearson representative.

MyStatLab™ Online Course (access code required) MyStatLab from Pearson is the world’s 
leading online resource for statistics learning, integrating interactive homework, assessment, and 
media in a flexible, easy to use format. MyStatLab is a course management systems that delivers 
proven results in helping individual students succeed.

MyStatLab™

www.pearsonhighered.com/irc
www.pearsoned.com/testgen
www.mathxl.com
www.mathxl.com
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•	 MyStatLab can be successfully implemented in any environment—lab-based, hybrid, fully 
online, traditional—and demonstrates the quantifiable difference that integrated usage has on 
student retention, subsequent success, and overall achievement.

•	 MyStatLab’s comprehensive online gradebook automatically tracks students’ results on tests, 
quizzes, and homework and in the study plan. Instructors can use the gradebook to pro-
vide positive feedback or intervene if students have trouble. Gradebook data can be easily 
exported to a variety of spreadsheet programs, such as Microsoft Excel. You can determine 
which points of data you want to export and then analyze the results to determine success.

MyStatLab provides engaging experiences that personalize, stimulate, and measure learning for 
each student. In addition to the resources below, each course includes a full interactive online ver-
sion of the accompanying textbook.

•	 Tutorial Exercises with Multimedia Learning Aids: The homework and practice exercises 
in MyStatLab align with the exercises in the textbook, and they regenerate algorithmically 
to give students unlimited opportunity for practice and mastery. Exercises offer immediate 
helpful feedback, guided solutions, sample problems, animations, videos, and eText clips for 
extra help at the point of use.

•	 MyStatLab Accessibility: MyStatLab is compatible with the JAWS 12/13 screen reader and 
enables multiple-choice and free-response problem types to be read and interacted with via 
keyboard controls and math notation input.

•	 StatTalk Videos: Fun-loving statistician Andrew Vickers takes to the streets of Brooklyn, 
NY to demonstrate important statistical concepts through interesting stories and real-life 
events. This series of 24 fun and engaging videos will help students actually understand sta-
tistical concepts. Available with an instructor’s user guide and assessment questions.

•	 Business Insight Videos: Ten engaging videos show managers at top companies using statis-
tics in their everyday work. Assignable question encourage debate and discussion.

•	 Additional Question Libraries: In addition to algorithmically regenerated questions that are 
aligned with your textbook, the MyStatLab courses come with two additional question libraries:
	 450 Getting Ready for Statistics covers the developmental math topics students need 
for the course. These can be assigned as a prerequisite to other assignments, if desired.
	 1000 Conceptual Question Library requires students to apply their statistical understanding.

•	 Integration of Statistical Software: We make it easy to copy our data sets, both from the 
eText and the MyStatLab questions, into software such as StatCrunch, Minitab, Excel, and 
more. Students have access to a variety of support tools—Technology Tutorial Videos, 
Technology Study Cards, and Technology Manuals for select titles—to learn how to effec-
tively use statistical software.

•	 Expert Tutoring: Although many students describe the whole of MyStatLab as “like having 
your own personal tutor,” students also have access to live tutoring from Pearson, from quali-
fied statistics instructors.

•	 StatCrunch®: MyStatLab integrates the web-based statistical software StatCrunch within 
the online assessment platform so that students can easily analyze data sets from exercises 
and the text. In addition, MyStatLab includes access to www.statcrunch.com, a website 
where users can access tens of thousands of shared data sets, conduct online surveys, perform 
complex analyses using the powerful statistical software, and generate compelling reports.

And, MyStatLab comes from an experienced partner with educational expertise and an eye on the 
future.

•	 Knowing that you are using a Pearson product means knowing that you are using quality 
content. That means that our eTexts are accurate and our assessment tools work. It means we 
are committed to making MyMathLab as accessible as possible.

•	 Whether you are just getting started with MyStatLab, or have a question along the way, we’re 
here to help you learn about our technologies and how to incorporate them into your course.

To learn more about how MyStatLab combines proven learning applications with powerful assess-
ment, visit www.mystatlab.com or contact your Pearson representative.

StatCrunch® is powerful web-based statistical software that allows users to perform complex anal-
yses, share data sets, and generate compelling reports of their data. The vibrant online community 
offers tens of thousands shared data sets for students to analyze.

www.statcrunch.com
www.mystatlab.com
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Full access to StatCrunch is available with a MyStatLab access kit, and StatCrunch is available by 
itself to qualified adopters. StatCrunch is now compatible with most mobile devices. To access, visit 
www.statcrunch.com/mobile from the browser on your smartphone or tablet. For more informa-
tion, visit our website at www.statcrunch.com, or contact your Pearson representative.
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1

U s i n g  S tat i s t i c s

“You Cannot Escape from Data”
Not so long ago, business students were unfamiliar with the word data and 
had little experience handling data. Today, every time you visit a search engine 
website or “ask” your mobile device a question, you are handling data. And 
if you “check in” to a location or indicate that you “like” something, you are 
creating data as well.

You accept as almost true the premises of stories in which characters 
collect “a lot of data” to uncover conspiracies, to foretell disasters, or to catch a 
criminal. You hear concerns about how the government or business might be able 
to “spy” on you in some ways or how large social media companies “mine” your 
personal data for profit.

You hear the word data everywhere and may even have a “data plan” for 
your smartphone. You know, in a general way, that data are facts about the  
world and that most data seem to be, ultimately, a set of numbers—that 49% of  
students recently polled dreaded taking a business statistics course, or that 
50% of citizens believe the country is headed in the right direction, or that 
unemployment is down 3%, or that your best friend’s social media account has 
835 friends and 202 recent posts.

You cannot escape from data in this digital world. What, then, should you 
do? You could try to ignore data and conduct business by relying on hunches or 
your “gut feelings.” However, if you only want to use gut feelings, then you prob-
ably shouldn’t be reading this book or taking business courses in the first place.

You could note that there is so much data in the world—or just in your 
own little part of the world—that you couldn’t possibly get a handle on it. 
You could accept other 
people’s data summaries 
and their conclusions 
without first reviewing 
the data yourself. That, 
of course, would expose 
yourself to fraudulent 
practices.

Or, you could 
do things the proper 
way and realize that 
you cannot escape 
learning the methods of 
statistics, the subject of 
this book . . .
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GS.1  Statistics: A Way of Thinking
Statistics is a way of thinking that can help you make better decisions. Statistics helps you 
solve problems that involve decisions that are based on data that have been collected. You may 
have had some statistics instruction in the past. If you ever created a chart to summarize data 
or calculated values such as averages to summarize data, you have used statistics. But there’s 
even more to statistics than these commonly taught techniques, as the detailed table of contents 
shows.

Statistics is undergoing important changes today. There are new ways of visualizing data 
that either did not exist, were not practical to do, or were not widely known until recently. And, 
more and more, statistics today is being used to “listen” to what the data might be telling you 
(the subject of Chapter 17) rather than just being a way to use data to prove something you 
want to say.

If you associate statistics with doing a lot of mathematical calculations, you will quickly 
learn that business statistics uses software to perform the calculations for you (and, generally, 
the software calculates with more precision and efficiency than you could do manually). But 
while you do not need to be a good manual calculator to apply statistics, because statistics is 
a way of thinking, you do need to follow a framework, or plan, to minimize possible errors of 
thinking and analysis. The DCOVA framework is one such framework.

The DCOVA Framework

The DCOVA framework consists of the following tasks:
•	 Define the data that you want to study in order to solve a problem or meet an objective.
•	 Collect the data from appropriate sources.
•	 Organize the data collected by developing tables.
•	 Visualize the data collected by developing charts.
•	 Analyze the data collected to reach conclusions and present those results.

The DCOVA framework uses the five tasks Define, Collect, Organize, Visualize, and Analyze 
to help apply statistics to business decision making. Typically, you do the tasks in the order 
listed. You must always do the first two tasks to have meaningful outcomes, but, in practice, 
the order of the other three can change or appear inseparable. Certain ways of visualizing data 
help you to organize your data while performing preliminary analysis as well. In any case, 
when you apply statistics to decision making, you should be able to identify all five tasks, and 
you should verify that you have done the first two tasks before the other three.

Using the DCOVA framework helps you to apply statistics to these four broad categories 
of business activities:

	 •	 Summarize and visualize business data
	 •	 Reach conclusions from those data
	 •	 Make reliable forecasts about business activities
	 •	 Improve business processes

Throughout this book, and especially in the Using Statistics scenarios that begin the chapters, 
you will discover specific examples of how DCOVA helps you apply statistics. For example, in 
one chapter, you will learn how to demonstrate whether a marketing campaign has increased 
sales of a product, while in another you will learn how a television station can reduce unneces-
sary labor expenses.
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GS.2  Data: What Is It?
Defining data in a general way as “facts about the world,” to quote the opening essay, can 
prove confusing as such facts could be singular, a value associated with something, or col-
lective, a list of values associated with something. For example, “David Levine” is a singular 
fact, a coauthor of this book, whereas “Mark, David, and Kathy” is the collective list of au-
thors of this book. Furthermore, if everything is data, how do you distinguish “David Levine” 
from “Basic Business Statistics,” two very different facts (coauthor and title) about this book. 
Statisticians avoid this confusion by using a more specific definition of data and by defining a 
second word, variable.

Data are “the values associated with a trait or property that help distinguish the occur-
rences of something.” For example, the names “David Levine” and “Kathryn Szabat” are data 
because they are both values that help distinguish one of the authors of this book from another. 
In this book, data is always plural to remind you that data are a collection, or set, of values. 
While one could say that a single value, such as “David Levine,” is a datum, the phrases data 
point, observation, response, and single data value are more typically encountered.

The trait or property of something that values (data) are associated with is what statisti-
cians define as a variable. For example, you might define the variables “coauthor” and “title” 
if you were defining data about a set of textbooks.

Substituting the word characteristic for the phrase “trait or property” and using the phrase 
“an item or individual” instead of the vague word “something” produces the definitions of 
variable and data used in this book.

Student Tip
Business convention 
places the data, the set 
of values, for a variable 
in a column when using 
a worksheet or similar 
object. The Excel and 
Minitab data worksheets 
used in this book follow 
this convention. Be-
cause of this convention, 
people sometimes use 
the word column as a 
substitute for variable.

Variable

A characteristic of an item or individual.

Data

The set of individual values associated with a variable.

Think about characteristics that distinguish individuals in a human population. Name, 
height, weight, eye color, marital status, adjusted gross income, and place of residence are all 
characteristics of an individual. All of these traits are possible variables that describe people.

Defining a variable called author-name to be the first and last names of the authors of this 
text makes it clear that valid values would be “Mark Berenson,” “David Levine,” and “Kathryn 
Szabat” and not, say, “Berenson,” “Levine,” and “Szabat.” Be careful of cultural or other 
assumptions in definitions—for example, is “last name” a family name, as is common usage 
in North America, or an individual’s own unique name, as is common usage in most Asian 
countries?

Having defined data and variable, you can define the subject of this book, statistics.

Statistics

The methods that help transform data into useful information for decision makers.

Statistics allows you to determine whether your data represent information that could be 
used in making better decisions. Therefore, statistics helps you determine whether differences 
in the numbers are meaningful in a significant way or are due to chance. To illustrate, consider 
the following news reports about various data findings:

	 •	 “Acceptable Online Ad Length Before Seeing Free Content” (USA Today, February 
16, 2012, p. 1B) A survey of 1,179 adults 18 and over reported that 54% thought that  
15 seconds was an acceptable online ad length before seeing free content.
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	 •	 “First Two Years of College Wasted?” (M. Marklein, USA Today, January 18, 2011, 
p. 3A) A survey of more than 3,000 full-time, traditional-age students found that the stu-
dents spent 51% of their time on socializing, recreation, and other activities; 9% of their 
time attending class/lab; and 7% of their time studying.

	 •	 “Follow the Tweets” (H. Rui, A. Whinston, and E. Winkler, The Wall Street Journal, 
November 30, 2009, p. R4) In this study, the authors found that the number of times 
a specific product was mentioned in comments in the Twitter social messaging service 
could be used to make accurate predictions of sales trends for that product.

Without statistics, you cannot determine whether the “numbers” in these stories represent use-
ful information. Without statistics, you cannot validate claims such as the claim that the num-
ber of tweets can be used to predict the sales of certain products. And without statistics, you 
cannot see patterns that large amounts of data sometimes reveal.

When talking about statistics, you use the term descriptive statistics to refer to methods 
that primarily help summarize and present data. Counting physical objects in a kindergarten 
class may have been the first time you used a descriptive method. You use the term inferential 
statistics to refer to methods that use data collected from a small group to reach conclusions 
about a larger group. If you had formal statistics instruction in a lower grade, you were prob-
ably mostly taught descriptive methods, the focus of the early chapters of this book, and you 
may be unfamiliar with many of the inferential methods discussed in later chapters.

GS.3  Business Analytics: The Changing Face of Statistics
The Using Statistics scenario that opens this chapter notes the increasing use of new statistical 
techniques that either did not exist, were not practical to do, or were not widely known in the 
past. Of all these new techniques, business analytics best reflects the changing face of statis-
tics. These methods combine traditional statistical methods with methods from management 
science and information systems to form an interdisciplinary tool that supports fact-based 
management decision making. Business analytics enables you to

	 •	 Use statistical methods to analyze and explore data to uncover unforeseen relationships.
	 •	 Use management science methods to develop optimization models that impact an orga-

nization’s strategy, planning, and operations.
	 •	 Use information systems methods to collect and process data sets of all sizes, including 

very large data sets that would otherwise be hard to examine efficiently.

Business analytics allows you to interpret data, reach conclusions, and make decisions 
and, in doing that, it combines many of the tasks of the DCOVA framework into one integrated 
process. And because you apply business analytics in the context of organizational decision 
making and problem solving (see reference 7), successful application of business analytics 
requires an understanding of a business and its operations. Chapter 17 examines business ana-
lytics more closely, including its implications for the future.

“Big Data”
Relatively recent advances in information technology allow businesses to collect, process, and 
analyze very large volumes of data. Because the operational definition of “very large” can be par-
tially dependent on the context of a business—what might be “very large” for a sole proprietorship 
might be commonplace and small for a multinational corporation—many use the term big data.

Big data is more of a fuzzy concept than a term with a precise operational definition, 
but it implies data that are being collected in huge volumes and at very fast rates (typically 
in real time) and data that arrive in a variety of forms, organized and unorganized. These 
attributes of “volume, velocity, and variety,” first identified in 2001 (see reference 5), make big 
data different from any of the data sets used in this book.

Big data increases the use of business analytics because the sheer size of these very large 
data sets makes preliminary exploration of the data using older techniques impractical to do. 
This effect is explored in Chapter 17.
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Statistics: An Important Part of Your Business Education
As business analytics becomes increasingly important in business, and especially as the use of 
big data increases, statistics, an essential component of business analytics, becomes increas-
ingly important to your business education. In the current data-driven environment of business, 
you need general analytical skills that allow you to manipulate data, interpret analytical re-
sults, and incorporate results in a variety of decision-making applications, such as accounting, 
finance, HR management, marketing, strategy/planning, and supply chain management.

The decisions you make will be increasingly based on data and not on gut or intuition sup-
ported by personal experience. Data-guided practice is proving to be successful; studies have 
shown an increase in productivity, innovation, and competition for organizations that embrace 
business analytics. The use of data and data analysis to drive business decisions cannot be 
ignored. Having a well-balanced mix of technical skills—such as statistics, modeling, and ba-
sic information technology skills—and managerial skills—such as business acumen, problem-
solving skills, and communication skills—will best prepare you for today’s, and tomorrow’s, 
workplace (see reference 1).

If you thought that you could artificially separate statistics from other business subjects, 
take a statistics course, and then forget about statistics, you have overlooked the changing face 
of statistics. The changing face is the reason that Hal Varian, the chief economist at Google, 
Inc., noted as early as 2009, “the sexy job in the next 10 years will be statisticians. And I’m not 
kidding” (see references 8 and 9).

This book helps you develop the skills necessary to use the DCOVA 
framework to apply statistics to the four types of business activities 
listed on page 2. Chapter 1 discusses the Define and Collect tasks, 
the necessary starting point for all statistical activities. Chapters 2 
and 3 explain the Organize and Visualize tasks and present methods 
that summarize and visualize business data (the first activity listed in 
Section GS.1). Chapter 3 also presents statistics used in the Analyze 
task. Chapters 4 through 12 discuss methods that use sample data 
to reach conclusions about populations (the second activity listed). 
Chapters 13 through 16 review methods to make reliable forecasts 
(the third activity). The online Chapter 19 introduces methods that 
you can use to improve business processes (the fourth activity) and 
the online Chapter 20 introduces decision-making methods. (As 
previously noted, Chapter 17 discusses business analytics.) Chapter 
18 summarizes the methods of this book and provides you with a 
roadmap for analyzing data.

Each chapter begins with a Using Statistics scenario that puts 
you in a realistic business situation. You will face problems that the 
statistical concepts and methods introduced in the chapter will help 
solve. Later, near the end of the chapter, a Using Statistics Revisited 
section reviews how the statistical methods discussed in the chapter 
can be applied to help solve the problems you faced.

Each chapter ends with a variety of features that help you re-
view what you have learned in the chapter. Summary, Key Equations, 
and Key Terms concisely present the important points of a chapter. 

Checking Your Understanding tests your understanding of basic con-
cepts, and Chapter Review Problems allow you to practice what you 
have learned.

Throughout this book, you will find Excel and Minitab solutions 
to example problems. You will also find many Student Tips, margin 
notes that help clarify and reinforce significant details about particu-
lar statistical concepts. Selected chapters include Visual Explorations 
features that allow you to interactively explore statistical concepts. 
And many chapters include a “Think About This” essay that explains 
important statistical concepts in further depth.

This book contains numerous case studies that give you an op-
portunity to enhance your analytic and communication skills. Appear-
ing in most chapters is the continuing case study Managing Ashland 
MultiComm Services that details problems managers of a residential 
telecommunications provider face and a Digital Case, which asks you 
to sort through information in electronic documents and then apply 
your statistical knowledge to resolve a business problem or issue. 
Besides these two cases, you will find a number of other cases, in-
cluding some that reoccur in several chapters, in this book.

Don’t worry if your instructor does not cover every section of 
every chapter. Introductory business statistics courses vary in terms 
of scope, length, and number of college credits earned. Your func-
tional area of study (accounting, management, finance, marketing, 
etc.) may also affect what you learn in class or what you are 
assigned to read in this book.

How to Use This Book
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In later chapters, these guides are keyed to the in-chapter section numbers and present 
detailed Excel and Minitab instructions for performing the statistical methods discussed in 
chapter sections. Table GS.2 presents the typographic conventions that the guides use to pres-
ent computer operations. Excel Guides additionally identify the key Excel technique that is 
used for a statistical method and include instructions for using PHStat, the Pearson Education 
statistics add-in that simplifies the operation of Microsoft Excel.

GS.4  Software and Statistics
You use software to assist you in applying statistical methods to business decision making. 
Microsoft Excel and Minitab are examples of applications that people use for statistics. Excel 
is the Microsoft Office data analysis application that evolved from earlier electronic spread-
sheets used in accounting and financial applications. Minitab, a dedicated statistical applica-
tion, or statistical package, was developed from the ground up to perform statistical analysis 
as accurately as possible. Versions of Minitab run on larger computer systems and can perform 
sophisticated analyses of large data sets.

Although you are probably more familiar with Excel than with Minitab, both programs 
share many similarities, starting with their shared use of worksheets (or spreadsheets) to store 
data for analysis. Worksheets are tabular arrangements of data, in which the intersections of 
rows and columns form cells, boxes into which you make entries. In Minitab, the data for 
each variable are placed in separate columns, and this is also the standard practice when using 
Excel. Generally, to perform a statistical analysis in either program, you select one or more 
columns of data and then apply the appropriate command.

Both Excel and Minitab allow you to save worksheets, programming information, and 
results as one file, called a workbook in Excel and a project in Minitab. In Excel, workbooks 
are collections of worksheets and chart sheets. You save a workbook when you save “an Excel 
file” (either as an .xlsx or .xls file). In Minitab, a project includes data worksheets, all the 
results shown in a session window, and all graphs created for the data. Unlike in Excel, in 
Minitab you can save individual worksheets (as .mtw worksheet files) as well as save the en-
tire project (as an .mpj project file).

Excel and Minitab Guides
You can use either Excel or Minitab to learn and practice the statistical methods learned 
in this book. Immediately following each chapter are Excel and Minitab Guides. For this 
chapter, special guides explain how the guides have been designed to support your learning 
with this book. To prepare for using Excel or Minitab, review and complete the checklist in 
Table GS.1 below.

T ab  l e  G S . 1

Checklist for Preparing 
to Use Excel or 
Minitab with This Book

❑  Determine which program, Excel or Minitab, you will use with this book.
❑ � Read and review the Excel or Minitab Guide for this chapter to verify your knowledge of required 

basic skills.
❑ � Read Appendix C to learn about the online resources you need to make best use of this book. 

Appendix C includes a complete list of the data files that are used in the examples and problems 
found in this book. Names of data files appear in this distinctive type face— Retirement Funds —
throughout this book.

❑ � Download the online resources that you will need to use this book, using the instructions in Appendix C.
❑ � Check for updates to the program that you plan to use with this book, using the Appendix Section 

D.1 instructions.
❑ � If you plan to use Excel with PHStat, the Visual Explorations add-in workbooks, or the Analysis 

ToolPak and you maintain your own computer system, read the special instructions in Appendix D.
❑  Examine Appendix G to learn answers to frequently asked questions (FAQs).
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Operation and Examples Notes

Keyboard keys 
  Enter Ctrl Shift

Names of keys are always the object of the verb press, as in 
“press Enter.”

Keystroke combinations 
  Ctrl+C 
  Ctrl+Shift+Enter 
  Command+Enter

Keyboarding actions that require you to press more than one key 
at the same time. Ctrl+C means press C while holding down 
Ctrl. Ctrl+Shift+Enter means press Enter while holding down 
both Ctrl and Shift.

Click or select operations
  click OK
  select the first 2-D Bar  
    gallery item

Mouse pointer actions that require you to single click an 
onscreen object. This book uses the verb select when the object 
is either a worksheet cell or an item in a gallery, menu, list, or 
Ribbon tab.

Menu or ribbon selection
  File ➔ New
  Layout ➔ Legend ➔ None

A sequence of Ribbon or menu selections. File ➔ New means 
first select the File tab and then select New from the list that 
appears.

Placeholder object 
  variable 1 cell range 
  bins cell range

An italicized boldfaced phrase is a placeholder for an object 
reference. In making entries, you enter the reference, e.g., 
A1:A10, and not the placeholder.

T ab  l e  G S . 2

Computing Conventions 
Used in This Book

The guides presume that you have knowledge of the basic computing skills listed in Table 
GS.3. If you have not mastered these skills, you can read the online pamphlet Basic Computing 
Skills. (Appendix C explains how you can download a copy of this and other online sections.)

T ab  l e  G S . 3

Basic Computing Skills
Basic Skill Specifics

Identification of 
application window 
objects

Title bar, minimize/resize/close buttons, scroll bars, formula bar, 
workbook area, cell pointer, shortcut menu. For Excel only, panes 
and these Ribbon parts: tab, group, gallery, and launcher button

Knowledge of mouse 
operations

Click (also called select), check and clear, double-click, right-click, 
drag/drag-and-drop

Identification of dialog 
box objects

Command button, list box, drop-down list, edit box, option button, 
check box
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E x c e l  G u i d e

EG.1 � Getting Started with Microsoft Excel
You can use Excel to learn and apply the statistical methods discussed in this book and as an aid in 
solving end-of-section and end-of-chapter problems. How you use Excel is up to you (or perhaps your 
instructor), and the Excel Guides give you two complementary ways to use Excel.

If you are focused more on getting results as quickly as possible, consider using PHStat. PHStat, 
available for users of this book, is an example of an add-in, an application that extends the functionality 
of Microsoft Excel. The PHStat add-in simplifies the task of operating Excel while creating real Excel 
worksheets that use in-worksheet calculations. With PHStat, you can create worksheets that are identical 
to the ones featured in this book while minimizing the potential for making worksheet entry errors. In 
contrast, most other add-ins create results that are mostly text pasted into an empty worksheet.

For many topics, you may choose to use the In-Depth Excel instructions. These instructions use pre-con-
structed worksheets as models or templates for a statistical solution. You learn how to adapt these worksheets 
to construct your own solutions. Many of these sections feature a specific Excel Guide workbook that contains 
worksheets that are identical to the worksheets that PHStat creates. Because both of these ways create the same 
results and the same worksheets, you can use a combination of both ways as you read through this book. 

The In-Depth Excel instructions and the Excel Guide workbooks work best with the latest 
versions of Microsoft Excel, including Excel 2010 and Excel 2013 (Microsoft Windows), Excel 
2011 (OS X), and Office 365. Where incompatibilities arise with versions older than Excel 2010, 
the incompatibilities are noted and alternative worksheets are provided for use. (Excel Guides 
also contain instructions for using the Analysis ToolPak add-in that is included with some 
Microsoft Excel versions, when appropriate.)

You will want to master the Table EG.A basic skills before you begin using Excel to understand 
statistical concepts and solve problems. If you plan to use the In-Depth Excel instructions, you will also 
need to master the skills listed in the second half of the table. While you do not necessarily need these 
skills if you plan to use PHStat, knowing them will be useful if you expect to customize the Excel work-
sheets that PHStat creates or expect to be using Excel beyond the course that uses this book.

T a b l e  E G . A

Skills Set for Using 
Microsoft Excel with 
This Book

Basic Microsoft Office Skill Specifics

Excel data entry Organizing worksheet data in columns, entering numerical and 
categorical data

File operations Open, save, print

Worksheet operations Create, copy

In-Depth Excel Skill Specifics

Formula skills Concept of a formula, cell references, absolute and relative cell 
references, how to enter a formula, how to enter an array formula

Workbook presentation How to apply format changes that affect the display of 
worksheet cell contents

Chart formatting correction How to correct the formatting of charts that Excel improperly creates

Discrete histogram creation How to create a properly formatted histogram for a discrete 
probability distribution

This guide reviews the basic Microsoft Office skills and Appendix B teaches you the In-Depth Excel 
skills. If you start by studying Sections B.1 through B.4 of that appendix, you will have the skills you 
need to make effective use of the In-Depth Excel instructions when you first encounter them in Chapter 1.  
(You can read other sections in Appendix B as needed.)

EG.2  Entering Data
As noted in Section GS.4, you enter data into the rows and columns of a worksheet. By convention, and 
the style used in this book, when you enter data for a set of variables, you enter the name of each variable 
into the cells of the first row, beginning with column A. Then you enter the data for the variable in the 
subsequent rows to create a DATA worksheet similar to the one shown in Figure EG.1.
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F i g u r e  EG  . 1
An example of a DATA 
worksheet

Student Tip
Most of the Excel data 
workbooks that you can 
download and use with 
this book (see Appen-
dix C) contain a DATA 
worksheet that follows 
the rules of this sec-
tion. You can use any of 
those worksheets as an 
additional model for data 
entry.

F i g u r e  EG  . 2
Excel 2013 Open and 
Save As dialog boxes

You select the storage folder by using the drop-down list at the top of either of these dialog boxes. You 
enter, or select from the list box, a file name for the workbook in the File name box. You click Open or Save to 
complete the task. Sometimes when saving files, you may want to change the file type before you click Save.

In Microsoft Windows Excel versions, to save your workbook in the format used by versions older 
than Excel 2007, select Excel 97-2003 Workbook (*.xls) from the Save as type drop-down list before 
you click Save.

To save data in a form that can be opened by programs that cannot open Excel workbooks, you 
might select either Text (Tab delimited) (*.txt) or CSV (Comma delimited) (*.csv) as the save type. 
In OS X Excel versions, the equivalent selections are to select Excel 97–2004 Workbook (.xls), Tab 
Delimited Text (.txt), or Windows Comma Separated (.csv) from the Format drop-down list before 
you click Save.

When you want to open a file and cannot find its name in the list box, double-check that the current 
folder being searched is the proper folder. If it is, change the file type to All Files (*.*) (All Files in OS 
X Excel) to see all files in the current folder. This technique can help you discover inadvertent misspell-
ings or missing file extensions that otherwise prevent the file from being displayed.

Although all versions of Microsoft Excel include a Save command, you should avoid this choice 
until you gain experience. Using Save makes it too easy to inadvertently overwrite your work. Also, you 
cannot use the Save command for any open workbook that Excel has marked as read-only. (Use Save As 
to save such workbooks.)

To enter data in a specific cell, either use the cursor keys to move the cell pointer to the cell or use 
your mouse to select the cell directly. As you type, what you type appears in the formula bar. Complete 
your data entry by pressing Tab or Enter or by clicking the checkmark button in the formula bar.

When you enter data, never skip any rows in a column, and as a general rule, also avoid skip-
ping any columns. Also try to avoid using numbers as row 1 variable headings; if you cannot avoid 
their use, precede such headings with apostrophes. Pay attention to any special instructions that oc-
cur throughout the book for the order of the entry of your data. For some statistical methods, enter-
ing your data in an order that Excel does not expect will lead to incorrect results.

EG.3 � Opening and Saving Workbooks
You open and save a workbook by first selecting the folder that stores the workbook and then speci-
fying the file name of the workbook. In most Excel versions, select File ➔ Open to open a workbook 
file and File ➔ Save As to save a workbook. (In Excel 2007, select Office Button ➔ Open to open a 
workbook file and Office Button ➔ Save As to save a workbook.) Open and Save As display nearly 
identical dialog boxes that vary only slightly among the different Excel versions. Figure EG.2 shows 
the Excel 2013 Open and Save As dialog boxes. To see these dialog boxes in Excel 2013, double-
click Computer in the Open or Save As panels, a step that other Excel versions do not require.




